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   HEC-RAS has the ability to import three-dimensional (3D) river schematic 

and cross section data created in a GIS or CADD system.  While the HEC-
RAS software only utilizes two-dimensional data during the computations, 
the three-dimensional information is used in the program for display 
purposes.  After the user has completed a hydraulic analysis, the computed 
water surface profiles can be exported back to the GIS or CADD system for 
development and display of a flood inundation map. 

 
   The importing and exporting of GIS or CADD data is accomplished through 

the use of formatted ASCII text files.  The text files provide a generic way of 
exchanging data between GIS/CADD systems and HEC-RAS, without 
adopting any single GIS/CADD system.  Appendix B of this manual 
provides a detailed description and examples of the file formats used for 
importing and exporting GIS or CADD data.   

 
   The HEC has developed an ArcView GIS extension called GeoRAS, that was 

specifically designed to process geospatial data for use with HEC-RAS.  The 
GeoRAS software allows a user to write geometric data to a file in the 
required format for HEC-RAS.  Additionally, the users can read the HEC-
RAS results into GeoRAS and perform the flood inundation mapping.  This 
software is not part of the HEC-RAS program.  The software and a user’s 
manual are provided as a separate program to be used with ArcView.  Also, 
the Intergraph Corporation has adding the capability to exchange data with 
HEC-RAS in their Software package called Storm and Sewer Works 
(Intergraph, 1999) 

 
   This chapter discusses how to import GIS or CADD data into HEC-RAS; 

what additional information will need to be added to complete the data; and 
how to export the results back to the GIS or CADD system. 
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General Modeling Guidelines 
 
   The current version of HEC-RAS has the ability to import the following 

geometric data from a GIS/CADD system: 
 
   River System Schematic.  The structure of the stream network as 

represented by a series of interconnected reaches.  Each reach is represented 
as a multi-point line, which is assumed to follow the invert of the main 
channel.  The River and Reach labels, as well as the Junction labels, are also 
imported from the GIS/CADD. 

 
   Cross Section Data.  The following cross section data can be imported from 

a GIS/CADD: 
 
   1. River, Reach, and River Station identifiers. 
 
   2. Cross Section Cut Lines (X and Y coordinates of the plan-view line 

that represents the cross section).  This is a multi-point line that can 
have two or more points. 

 
   3. The cross section surface line.  This line is sent to HEC-RAS as a 

series of X, Y, Z coordinates for each point in the cross section.  
HEC-RAS transforms these coordinates into station and elevation 
points (X and Y) for computational purposes.  The first station of the 
cross section is always set to zero.  The true (real world) coordinates 
of the cross section are recomputed from the cross section cut line for 
the purposes of displaying the data (3D plot). 

 
   4. Cross section main channel bank stations. 
 
   5. Downstream reach lengths for the left overbank, main channel, and 

right overbank. 
 
   6. Manning’s n values. 
 
   7. Levee locations and elevations. 
 
   8. Ineffective flow areas. 
 
   9. Top of road station and elevation for bridges and culverts. 
 
   10. Storage area boundaries and elevation versus volume relationship. 
 
   At this time, contraction and expansion coefficients, optional cross section 

properties (blocked obstructions, etc.), and hydraulic structure data (bridges, 
culverts, etc..) are not imported from a GIS/CADD system.  Many of these 
variables will be added in future versions of the software. 

 
   The general procedure for utilizing GIS/CADD data with HEC-RAS is the 

following: 
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   1. The first step is to start a New Project.  This is accomplished from the 

File menu of the main HEC-RAS window. 
 
   2. The next step is to go to the Geometric Data editor and import the 

GIS/CADD data into HEC-RAS.  GIS/CADD data are imported by 
selecting Import Geomtric Data, and then GIS Format from the 
File menu on the Geometric Data window.  This is assuming that you 
have already used a GIS system to write the required geometry data 
into a text file, using the required HEC-RAS format.  The format of 
this file is described in Appendix B of this manual. 

 
   3. After the GIS data are imported, the user will need to add any 

additional geometric data that is needed to represent the physical 
system.   

 
   4. The next step is to perform the water surface profile calculations for 

the desired flow rates. 
 
   5. Once the water surface profiles are calculated, the user can then 

output the results to a text file using the Export GIS Data option 
from the File menu of the main HEC-RAS window. 

 
   6. The last step is to import the HEC-RAS results file into the 

GIS/CADD system and develop the floodplain maps for each of the 
profiles. 

 
    
   Once the user has a project that is utilizing GIS data, then additional data can 

be imported directly into an existing HEC-RAS geometry file without starting 
a new project.  This allows the user to go back to the GIS and extract 
additional cross sections on an as-needed basis.  The HEC-RAS program will 
automatically place the new cross sections into the appropriate River and 
Reach, based on the identifiers defined for each cross section in the GIS 
import file. 

 
   After the user has performed the hydraulic analyses, the computed water 

surface profiles information can be written to a text file, which can then be 
imported into the GIS for development and display of floodplain maps.  HEC-
RAS exports the cross section Cut Line coordinates (X and Y), as well as the 
water surface elevation for each profile.  This is done for every cross section 
in the model.  Additionally, the program exports a series of bounding 
polygons (one per river reach) for each computed profile.   For information 
on the HEC-RAS GIS export file format, review the detailed write up found 
in Appendix B of this manual. 
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Importing GIS or CADD Data Into HEC-RAS 
 
   Within HEC-RAS, GIS data are imported from the Geometric Data Window.  

To import geometric data from a GIS/CADD system into HEC-RAS, the 
following steps should be followed: 

 
   1. The first step is to extract the necessary geometric information from a 

GIS/CADD system and write it to a text file in the required HEC-
RAS format.  As mentioned previously, HEC has developed an 
ArcView GIS extension called GeoRAS to help you do this.  
Likewise, the Intergraph Corporation has added this capability to their 
program called Stream and Storm Works.  You have the option of 
obtaining the GeoRAS software from HEC (for use in ArcView); 
using the software developed by Intergraph; or developing your own 
routines to extract this data from the GIS/CADD system of your 
choice.  The file formats for the required text file are outlined in 
Appendix B of this manual.   

 
   2. The next step is to start a new project in HEC-RAS.  This is 

accomplished by selecting the New Project option from the File 
menu of the main HEC-RAS window.  This option will allow the user 
to enter a project title and filename. 

 
   3. After a new project is started, the user should open the Geometric 

Data Editor.  Once the editor is opened, the user can import 
GIS/CADD data into HEC-RAS by selecting the Import Geometry 
Data - GIS Format option from the File menu of the Geometric Data 
window.  When this option is selected, a window will appear (Figure 
14.1) in which the user can select the file that contains the geometry 
data from the GIS. 

 

 
 

  Figure 14.1  Window for Selecting GIS Data File To Import 
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   4. Once the user selects the file containing the GIS data, and then 
presses the OK button, a window will appear that will show you what 
is available within the import file, and it will allow you to select what 
you want to import (Figure 14.2) 

 

 
 
   Figure 14.2  GIS Data Import Options Window 
 
 
   As shown in Figure 14.2, the user has several options when importing GIS 

data.  There are four tabs at the top of the window.  The first tab is just an 
introductory tab that explains how to proceed.  The second tab River Reach 
Steam Lines, allows the user to select which reaches found in the import file 
will be imported.  The next tab, Cross Sections and IB Nodes, allows the 
user to select which cross sections and internal boundaries (bridges and 
culverts) will be imported, as well as what specific cross section properties to 
import.  The final tab, Storage Areas and Connections allows the user to 
select which storage areas and connections between storage areas to import.   

 
   After making the selections of what to import, The user presses the Finished 

– Import Data button.  The data will be imported and a schematic of the river 
system will show up in the Geometric Data window (Figure 14.3).  Once the 
importing of the data is completed, the user should save the geometric data by 
selecting Save Geometry Data As from the File menu of the Geometric Data 
window.   
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 Figure 14.3  River System Schematic of Imported GIS Data  
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Completing The Data and Performing The 
Computations 
 
 
   Completing The Geometric Data 
 
   Once the user has imported the geometric data from a GIS/CADD system, the 

next step is to add any additional data required to perform the analyses.  
Depending on what data was extracted from the GIS (i.e. if n-values were not 
extracted from the GIS), the user may be required to enter Manning’s n 
values for all of the cross sections.  Manning’s n values can be entered 
directly from the cross section data editor (on a cross section by cross section 
basis) or through the Manning’s n-values table (this is the preferred way 
because the n values can be entered more efficiently).  The Manning’s n value 
table is available from the Tables menu on the Geometric Data window.  

 
   In addition to the Manning’s n values, the user may need to enter the 

following data to complete the geometry file: additional user entered cross-
section data; interpolated cross sections; optional cross section properties 
(ineffective flow areas, levees, blocked obstructions, etc.); and hydraulic 
structures (bridges, culverts, weirs and spillways).   

 
    
   Entering Additional Cross Section Data 
 
   If additional cross sections are entered by the user from the cross section 

editor (or through the HEC-2 import feature), the user will need to enter the 
coordinates of the cross section strike line in order to maintain a geospatially 
correct schematic and XYZ plot.  The cross section strike line coordinates can 
be entered by selecting XS Schematic Lines from the Edit menu on the 
Geometric Data window.  When this option is selected a window will appear 
as show in Figure 14.4. 
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   Figure 14.4  Cross Section Schematic Line X and Y Coordinates 
  
 
   The coordinates that are entered for the cross section schematic lines must be 

consistent with the previously entered GIS data (i.e., if the GIS data is in state 
plane coordinates, then the user entered data must also be in state plane 
coordinates).  Once all of the cross section schematic lines have consistent 
coordinates, the schematic and XYZ plot will provide a geospatially correct 
display of the cross sections.   
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   Performing The Computations and Viewing Results 
 
   Once the user has completed the geometric data file, flow data can be entered 

and the computations can be performed.  When utilizing GIS data, there are 
no special requirements for entering flow data or performing the 
computations.  Once the hydraulic computations are completed, the user can 
begin to review the output.  When GIS data are utilized, the HEC-RAS XYZ 
perspective plot has the ability to plot a true three dimensional perspective of 
the river system and the water surface profiles.  An example XYZ plot with 
GIS data is shown in Figure 14.5. 

 

 
 
 
   Figure 14.5  XYZ Perspective Plot With GIS Data 
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Exporting Computed Results To The GIS or CADD 
 
   Once the user has completed all of the hydraulic calculations, the computed 

water surface profiles can be exported to the GIS/CADD in order to develop 
floodplain maps.  The HEC-RAS results are exported to an ASCII text file, 
which can then be imported by the GIS/CADD system.  The format of the 
HEC-RAS results file is documented in Appendix B of this manual.   

 
   Exporting the HEC-RAS computed water surface profiles to a GIS/CADD 

system is accomplished by selecting Export GIS Data from the File menu on 
the main HEC-RAS window.  Once this option is selected, a window will 
appear as shown in Figure 14.6. 

 

 
 
   Figure 14.6   Window to Enter a Filename For Exporting 
     Results to GIS  
 
 

  As shown in Figure 14.6, the user first enters a filename for the HEC-RAS 
Export file.  Next, the user can select what they would like to export.  
Normally the user would select "Export Water Surfaces," and then select 
which profiles to export by using the Select Profiles to Export button.  Once 
these options are selected, the information can be exported by pressing the 
Export Data button.   
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   Additional options are available to export geometry data from HEC-RAS to 
the GIS/CADD system.  This option can be very useful for supplementing 
terrain data with additional surveyed cross sections.  It is a common 
occurrence for terrain models to have good information in the overbank areas, 
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but not as good, if at all, in the main channel.  HEC-RAS allows the user to 
export the entire cross section, or just the main channel portion only.  Also, 
the user can send all cross sections, including interpolated sections, or they 
can turn off the interpolated cross sections.  Additionally, there are options to 
send reach lengths, bank stations, levees, and ineffective flow areas to the 
GIS system. 

 
   In order to use the feature of sending terrain data from HEC-RAS to the GIS, 

the user must enter geospatial coordinates for all of the cross sections, and the 
stream centerline before exporting the data.  These coordinates are required in 
order to correctly locate the data spatially within the terrain model. 
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